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1 Product Overview

1.1 Introduction to the DB1 Differential Pressure Battery Charger

The DBL1 Differential Pressure Battery Charger from Parker PGI is an efficient and reliable alternative to solar
panel systems that are used to power electronic instruments on gas pipelines. The DB1 continuously monitors
the battery’s temperature and charge level and can produce up to 50 watts to keep the battery charged. In
applications where a lead acid battery is used to provide high peak power for short burst requirements (such as
for wireless communications at remote monitoring sites), the DB1 can produce a 12 or 24 volt power output to
keep the battery fully charged.

Unlike solar panels, the DB1 can be installed in almost any location where adequate differential pressure exists,
and it is not affected by environmental factors such as shade, snow, freezing rain, ice, dust buildup, or birds.

Figure 1-1. DB1 differential pressure battery charger

1.1.1 System Components

The DB1 system consists of three main components: the generator, the controller, and the battery interface
module (Figure 1-2 below).

OSC0OD

Figure 1-2. DB1 components
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The battery charger system uses the differential pressure developed across a pressure reducing device on
natural gas pipelines to run a small turbine-powered generator. The generator output can be used to charge a
lead acid battery, similar to the thermo-electric chargers (TECs) from Parker PGI. Unlike the TECs, the DB1
does not consume any natural gas. Power is produced by allowing a small portion of the gas to flow through a
turbine, bypassing the pressure reducing device. In relation to the total line flow, the amount of gas flow through
the DB1 turbine is low. The amount of gas flow is also stable, keeping the DB1 transparent to the pressure. The
pressure reducing device automatically adjusts for the slight decrease in flow resulting when the DB1 runs.
Controlled by a microprocessor, the power generated provides the ideal temperature compensated battery
charging current and voltage to the battery.

The controller provides the ON / DISABLE switch, connectors for field wiring, status and alarm LEDs, and the
connection for the diagnostic cable to the PC for system setup and monitoring via the DB Monitor software.

The battery interface module contains the battery temperature sensor, over-current protection, and the battery
interface wiring terminal.

The generator and the controller each have a microprocessor. By using separate microprocessors, the generator
can monitor itself and the communications link to the controller and shut the control valve using power from the
generator (until the turbine stops) if necessary. The generator will monitor the RPM, the charge current, the
control valve position, and the input voltage while controlling the valve motor and the optional flow restrictor. All
other parameters (battery voltage, battery temperature, remote shutdown (RSD) input, alarm output, status
LEDs) are monitored and managed by the controller microprocessor.

1.1.2 Features

o Powered by natural gas to 1,440 psig system pressures.

e Start-up and diagnostics controlled by microprocessor.

¢ Integrated temperature compensated charger with remote battery temperature sensor.
e User-configurable operating parameters.

e Status output for remote monitoring.

e Generator can be mounted directly on the pipeline or via optional 2” pipe mount. Controller can be wall
mounted.

e 10, 20, or 50 watts of charging power.
o Charge either 12 volt or 24 volt batteries (detected and set by the controller).

¢ Input to allow a switch or remote shutdown device (RSD) to disable the system. Signal may need to go
through a barrier if connected to an intrinsically safe device in the hazardous location (the RSD is a failsafe
feature that allows for remote activation / deactivation of the DB1).

e Status and alarm LEDs. Reference “LEDs” (page 19) for detailed descriptions.
e ON/DISABLE switch.
¢ RUN command regardless of battery voltage.

¢ Two configurable open collector alarm outputs. Reference “Alarm Contacts” (page 19) for a detailed
description.

o Event log with battery voltage, date, and time stamp (1,000 events).
¢ Turbine maintenance log and maintenance timer to track service due.

e Safely shut down the turbine if any wires between the generator and controller are cut or disconnected or if
the battery is disconnected.
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RS-485 Serial / Ethernet MODBUS communication protocol. (COM option)
Can handle up to 8% H2S and 8% CO2 in gas stream. (SVR option)

1.1.3 Models

DB1-10: 10 watts maximum
DB1-20: 20 watts maximum

DB1-50: 50 watts maximum

1.1.4 Options

VCH: Carbon steel remote mount kit for mounting to 2” Pipe Stand

VSH: Stainless steel remote mount kit for mounting to 2” Pipe Stand

COM: RS-485 Serial / Ethernet MODBUS communication protocol

SVR: Severe Service package for up to 8% H2S and 8% CO2 in gas stream

1.1.5 Accessories

SK-DB1-003: Diagnostics cable
P8-214-A0: 3/4” NPT pipe union
P8-215-C0: 1/2” 316 ss ball valve
SS-C9E-500-CL: 0 — 2,000 psi gauge
SS-C9E-516-CL: 0 — 300 psi gauge
SS-C9E-517-CL: 0 — 600 psi gauge
SS-C9E-518-CL: 0 — 1,000 psi gauge

Note: All gauges are 316 ss, liquid-filled, 1/4” MNPT center back mount with a 2-1/2” dial.

1.2 Requirements for Start-Up

The requirements for DB1 start-up are listed below. Failure to meet any of the requirements will result in failure
to start or improper operation. Repeated attempts at start-up may drain the battery voltage to a level below the
start-up requirement (10 V for a 12 V system and 20 V for a 24 V system).

1.

An adequate pressure differential.

A minimum pressure differential of 65 psig is required to operate the DB1 at 10 watts (85 psig to operate at
20 watts or 125 psig to operate at 50 watts). The power output will drop as the differential pressure is reduced.
The maximum inlet pressure is 1,440 psig.

A properly sized battery.

A properly sized battery is necessary for optimum performance of the DB1. If the battery is too small, it will
drain and charge very quickly, leading to short cycling of the DB1 and reduced battery life.

A properly charged battery.

A drained battery may not provide enough voltage to allow communication between the controller and the
generator. If the battery voltage is less than 10 volts for a 12 volt system or less than 20 volts for a 24 volt
system, charge or replace the battery, and then restart the DBL1.
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1.3 DB1 Performance

The DB1 battery charger uses the differential pressure developed across a pressure reducing device on natural
gas pipelines to run a small turbine-powered generator. DB1 performance is based on two factors:

(1) There must be a differential pressure in excess of 65 psig between the inlet side and the outlet side of
the DB1 to operate at 10 watts (85 psig for 20 watts or 125 psig for 50 watts).

(2) The amount of current generated is directly proportional to the wattage of the DB1 (10, 20, or 50 watts).

Following is a list of conditions that affect these two factors.

1.

The differential pressure available to activate the turbine.

The inlet tubing must have a minimum inside diameter of 3/8”, and the outlet tubing must have a minimum
inside diameter of 1/2”. Improperly sized tubing can cause flow restrictions that could affect the differential
pressure.

The angle of installation.

It is recommended that the DB1 generator be installed in an upright position.

A change in differential pressure.

Changes in differential pressure could affect the output power of the generator.
A high supply gas pressure.

Supply gas higher than 1,440 psig will exceed the rated pressure capability of the generator, causing the
DBL1 to fail.

Exposure to wet and cold gas.

Moisture in the gas supply, along with a low gas temperature, can cause icing / freezing of the gas that will
affect the spinning of the turbine.
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1.4 Specifications
Table 1-1. DB1 specifications

Hazardous Location Classification Class I, Division 1, Group D certified

Charger output 12 / 24 V (temperature compensated) for lead acid
batteries

Output power when charging 10 /20 /50 W continuous at 68°F (20°C) ambient

Remote battery temperature sensor Silicone diode

Alarm status and notification LED and (2) NPN open collectors

30V, 200 mA maximum

Transient protection Bi-directional TVS 1,500 watts peak pulse power
Battery short circuit protection 10 amp PTC over-current protection

Electrical connections (2) 1/2” rigid conduit openings, explosion proof
Wire connections Terminal strip with screw clamp

14 AWG maximum

Communication RS-485 Serial / Ethernet MODBUS protocol

Inlet gas supply pressure 1,440 psig maximum

Gas flow during charge cycle 30 scfm at 10 W / 40 scfm at 20 W / 65 scfm at 50 W
Gas supply connections Inlet: 3/8” OD stainless steel tubing

Outlet: 3/4” FNPT

Operating temperature range -40°F to 140°F (-40°C to 60°C)
Enclosure Cast Alum A356-T6, 316 SS NEMA 4X
Mounting configurations of generator Direct mount or optional 2” pipe mount
Weight 15 Ibs.
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2 Installation

2.1 Notes for Optimal Performance

/I\ WARNING! /I\

The electrical connections between the generator and the controller / battery interface must be
through conduit with an explosion proof wire seal fitting at the generator end.

/I\ WARNING! /I\

Connections between the generator and controller must be through conduit with an explosion
proof wire seal fitting at the generator end.

/I\ WARNING! /I\

The generator shall be installed on or near the pipeline, typically in a Division 1 or 2 hazardous
location. The controller and battery interface module will be mounted near the battery in a safe
non-hazardous location.

/I\ WARNING! /I\

Failure to comply could result in serious injury and even death!

/I IMPORTANT! /I\

The inlet and outlet valves should be closed during installation.

Following are installation guidelines to be followed that will ensure optimal performance of the DB1 system. The
recommended system installation is shown in Figure 2-1 (page 16).

1.

The DB1 generator must be installed across a pressure reducing device that will result in a minimum
pressure differential of 65 psig between the inlet side and the outlet side for a 10 W unit (85 psig for 20 W
or 125 psig for 50 W).

In order to achieve the necessary flow through the generator, it is very important that full opening ball
valves be installed at the inlet and outlet.

Install the generator in an upright position. If constraints exist, however, the generator may be installed on
an angle not to exceed 45° off vertical.

Blow out any existing ball valves prior to connecting the tubing.

A new run of tubing may contain small metal shavings that could jam the turbine. Blow out the tubing prior
to connecting it to the battery generator.

The inlet should be located on the pipeline before any gate valves to prevent interruption of the pressure
source (which would disable the DB1 system).

Use 3/8” minimum tubing on the inlet side.
Use 1/2” minimum tubing or pipe on the outlet side.

To visually verify that the unit is “seeing” the required input pressure, it is recommended that a pressure
gauge adequate for operating conditions be installed as close to the inlet side of the generator as possible.
A recommended pressure gauge is listed in “Accessories” (page 11).
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10. For direct mount systems, it is recommended that a pipe union be installed between the generator and the
full opening gate valve. This will facilitate removal and mounting.

11. The controller should be mounted near the battery in a safe area location.

12. The battery interface module should be mounted directly on or as close as possible to the battery.
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Figure 2-1. Recommended system installation
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2.2 Field Wiring Connections

To interface the DB1 generator with the external battery it will keep charged, a 30’ cable and a battery interface
module is provided. The 30’ cable will be used to connect the generator to the controller. Cut off any excess and
use it to connect the controller to battery interface module. Connections are shown in Figure 2-2 (page 18).

The generator will not start with a dead battery. In order for the generator to start, the battery to be charged must
measure greater than 10 V for a 12 V system and greater than 20 V for a 24 V system.

The battery interface module contains a temperature sensor and over-current protection and should be attached
directly onto or as close as possible to the battery being charged.

The components listed in Table 2-1 below may be purchased separately.

Table 2-1. Additional components for field wiring

Component

Part Number Cable Specification

Battery interface cable, 30°

SS-C85-1553 2 conductor: 14 AWG unshielded Alpha Wire 1891C
SLOO05 or equivalent

Generator to controller
interface cable, 30’

SS-C85-1468 3 conductor: 20 AWG shielded Alpha Wire 2413C
SLOO05 or equivalent
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/I\ WARNING! /I\

Ensure the DB1 power switch is in the DISABLE position and the battery (+) lead is
disconnected prior to making field connections!

/I\ WARNING! /I\

Connect the DB1 side first. Then connect the remote battery.

Note: Refer to Section A.2.2 (page 45) for field wiring of the COM communication option.

GENERATOR
CIRCUIT BOARD

20-28

AN

NOTE: Cut a section of S5-C85-1468 (3 conductor cable) to
make the connection between the controller and the battery

interface.

IMPORTANT! Do not connect DB battery output (BAT+ and
BAT-) to RTU or flow computer charger input.

ps()[@

DB+ | @

Q2D

/

MULTICONDUCTOR CABLE,
UNSHIELDED; 2 CONDUCTOR 14 AWG
; ALPHAWRE 1891CSLO0S (5)

BATTERY
INTERFACE

OB ¢ BAT+|

o4
OB« BAT - IQ!

"

~o  : 7-\/ -
=
\ DB
\;
@
\ P
| MULTICONDUCTOR CABLE, (4) | ACID BATTERY
SHIELDED; 3 CONDUCTOR 20 AWG
HAZARDOUS AREA | SAFE AREA e o oSOk
- 20° - 25° —
GREATER DISTANCES REQUIRE
HEAVIER GAUGE WIRE
Figure 2-2. Field wiring connections
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3 Operating Instructions

3.1 Overview

The DBL1 controller provides the operator with visual indicators of system status and alarm conditions via the
LEDs. The operator can access this and other information by connecting the diagnostics cable from the
communication port on the controller to a PC that has the DB Monitor software installed.

This chapter provides information on the operating features of the DB1 controller and instructions for software
configuration and starting up the DB1 system.

3.2 DB1 Controller

The DB1 controller provides the ON / DISABLE switch, status and alarm LEDs, and the communication port for
connecting the diagnostics cable.

The controller toggle switch does not remove power from the DB1 system. The controller will continue to function
when the switch is in the DISABLE position, but the generator will not be allowed to run or open the control valve.
If the switch is moved to the DISABLE position while the unit is charging, the control valve will be closed and
disable charging.

3.2.1 LEDs

The controller has three LEDs: the status LED (STATUS) and two alarm output LEDs (OUT1, OUT2). See Figure
3-1 below.

STATUS ON

G
5 PYX1, e
@ 5 L}‘i"s::;\J‘l'EMP

DISABLE
ALARM1 @
GND

ALARM2

STATUS

ALARMA1

ALARM2

Figure 3-1. Controller LEDs
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Table 3-1 below lists the conditions indicated by the status LED.

Table 3-1. Conditions indicated by status LED

Condition

Indicated by

Standby: The toggle switch is in the ON position, but
the generator is not running.

Flashing green.

Charging: The generator is running.

Solid green.

Shutdown: The system has been disabled.

Flashing red.

Waiting to Retry: No generator output detected.
System waiting to retry.

Flashing yellow.

Table 3-2 below lists the conditions indicated by the two alarm output LEDs.

Table 3-2. Conditions indicated by alarm output LEDs

Condition

Indicated by

No alarms.

OFF.

Minor alarm: A warning. The DB1 generator may
continue to function.

Flashing yellow.

Major alarm: The DB1 generator will be disabled (shut
down).

Flashing red.

Minor and major alarm conditions exist
simultaneously.

Flashing red and yellow alternately.

3.2.2 Alarm Contacts

The open collector alarm output can be used to remotely monitor DB1 health. When the output is “shorted,” the
DB1 generator is healthy. If the alarm circuit is “opened,” the generator has either been disabled or has shut
down and is no longer charging the battery. There are several tests performed on the generator to detect
malfunctions and to safely shut down the system. If the generator shuts down, the battery will continue to power
the connected device for a period of time determined by the battery size and device power requirements.

The alarm outputs are configurable and can be used to indicate major and minor alarms. In the event of a major
alarm, the system will be disabled. A minor alarm serves as a warning of undesirable conditions. The DB1 system
will continue to function during a minor alarm condition. Table 3-3 (page 21) lists the major and minor alarms.
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Table 3-3. Alarm conditions indicated by alarm outputs

Condition

Alarm Type

Lost generator communication.

Major, non-latched.

Control valve is full open but no RPM detected.

Major, latched.

Control valve failed.

Major, latched.

Generator RPM or voltage output too high.

Major, latched.

Turbine RPM sensor failed.

Major, latched.

Control valve position sensor failed.

Major, latched.

ON / DISABLE switch in DISABLE position.

Minor, non-latched.

Unable to generate maximum power with control valve
full open.

Minor, latched.

Generator run time service due.

Minor, latched.

RSD input detected.

Minor, non-latched.

Temperature sensor failed.

Minor, non-latched.

Unable to reach full charge.

Minor, non-latched.

MODBUS shutdown.

Minor, latched.
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3.3 The DB Monitor Software

3.3.1 Diagnostics Cable

A diagnostics cable (SK-DB1-003) is provided to enable communication between the DB1 and the DB Monitor
software. Connect one end of the cable to a USB port on the PC that will be used and the other end to the
communication port on the controller. Figure 3-2 below shows the diagnostics cable.

Note: For information on the COM communication option, refer to Appendix A (page 41).

Figure 3-2. Diagnostics cable

3.3.2 Installing the Software
1. Install the DB Monitor software from the CD provided or the Parker PGl web site (www.pgiint.com).

2. Connect the USB end of the diagnostics cable (SK-DB1-003) to a USB port on the PC. Connect the other
end of the cable to the communication port on the DB1 controller, shown below in Figure 3-3.

STATUS ON

ESD 6‘

DISABLE

Communication port
for diagnostics cable

Figure 3-3. Communication port

3. Double-click the DB Monitor icon to start the program. The |.D. screen will be displayed. See Figure 3-4
(page 23).
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http://www.pgiint.com/

DB Monitor Version 2.0.0.0

%
=

File

1.D.

Setup  Calibrate

Test  Help

| Status | Configuration | MODBUS |

Controller

Tag: DB1-50
Model: DB Battery Charger Controller

Hardware Revision: 6

Firmware Revision: 11
Calibration Date: Wednesday, January 23, 2013

MODBUS Address: 10

Generator

Model: DB 50 Watt Generator

Hardware Revision: 1
Firmware Revision: 10

3.3.3 The Start-Up Screen

COM20 | ONLINE

Figure 3-4. DB Monitor icon and |.D. screen

When you open the DB Monitor software, the start-up screen appears. Four tabs are displayed:

e |.D.: The I.D. tab displays controller and generator information. See Figure 3-4 above for an example.

e Status: The Status tab displays the present state of the generator and battery. The Status tab is discussed
later in “Preparing for Start-Up” (page 27).

e Configuration: The Configuration tab allows you to edit system configuration and alarms. The Configuration
tab is discussed later in “Preparing for Start-Up” (page 27).

¢ MODBUS: Refer to Appendix A (page 41) for information on the COM communication option.

3.3.3.1 The Menu Bar

The menu bar consists of the following main menus: File, View, Setup, Calibrate, Test, and Help.

File

Access the File menu to connect to the DB1 or exit the software. See Figure 3-5 below.

</ DB Monitor Yersion 2.0.0.0

‘.jile., View Setup  Calbrate Test Help

| Connect...
Exit  Ctrl+X

e
ion| MODBUS |

Figure 3-5. File menu

Rev 06

23 Parker PGI



View

Access the View menu (Figure 3-6 below) to view the DB Gauges screen and event log.

</ DB Monitor Yersion 2.0.0.0

File | View | Setup  Calbrate Test Help

Gauges... Fz .
us |

Event Log... F3

Figure 3-6. View menu

DB Gauges screen

The DB Gauges screen graphically displays the status of the battery and charger. An example is shown

below in Figure 3-7.

DB Gauges

Battery
1261V 74°F
8 9 10 1 12 13 14 15 16
[ S S T ] S E] o e Sy N 1 & b 1 . .1 *t L 1 -t 1 L 11 | I |
Volts ‘
Charger

O Standby
M Charging
[J Disakled

Figure 3-7. DB Gauges screen
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Event Log screen

The Event Log screen can display up to 1,000 events. The date, time, and battery volts for each event are
also displayed. See Figure 3-8 below for an example. The following events can be logged:

e Starttime

e Stop time

e Alarms

e Remote shutdown

e ON/DISABLE switch was switched

e Run or disable commands were turned on and off

e The cable was cut or interface malfunction shutdown. Lost communication link.

Event i.og
|l Save | ) Clearall Events | > Tag Mew Events As Read
Total Events 30 No Events to display
NewEvents 30 MNo new Events to display
Marked as Read 0
Displayed 30
30 out of 30 Events 7
Count  Time Stamp  (mm/dd/yy) Battery Event -
1 (04/08/13, 0156:32PM 13 | ALARM on Dutput2 Cleared I
2 |04/08/13,0156:32PM 1317V | Temperature sensor in range, compensation restored |
3 |04/08/13,0156:32PM 1317V ALARM on Outpu2Active B
4 ?EWDS/‘I 3, 01:56:31 PM 1 317 Temperature st.a.nsor failed, compensation disabled ‘
75 | 04/08/13, 01:56:30 PM 1318 | ALARM on Output? Cleared \
78 .1704208/1 3, 01:56:30 PM 1318 } Temperature sensor in range, compensation restored | —
7 |04/08/13015630PM 1318V | ALARM onOutpu2Active |
8 04/08/13, 01:56:30 PM 13.18v | Temperature sensor failed, compensation disabled \
9 } 04/08/13, 01:56:30 PM 1318V | ALARM on Output2 Cleared \
1 0 Aj704/08.4'1 3, 01:56:30 PM 1 318V ’ Temperature sensor in range, compensation restore \
11 |04/08/13,015549PM  1322¢ | ALARM on Outpu2Active ]
12 |04/08/13,015543PM 1322 | Temperature sensor failed, compensation disabled |
71 3 E04/08/1 3, 01:55:43 PM 13.22¢ | ALARM on Output? Cleared =

Figure 3-8. Event Log screen

Setup

System setup is discussed later in “Preparing for Start-Up” (page 27).
Calibrate

Calibration is discussed later in “Preparing for Start-Up” (page 27).
Test

Testing is addressed later in “System Tests” (page 35).
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Help

The Help menu provides access to the About screen, which displays software information. See Figure 3-9
and Figure 3-10 below.

< DB Monitor Version 2.0.0.0

File  View

.......................

Setup  Calibrate  Test | Help I

“ about. ..

Figure 3-9. Help menu

Parker PGI - Zeus Powver Systems DB Battery Charger and Powver Supply

2

"D

ELIS

POWER SsYSTEMS

DB Monitor 2.0

Version 2.0.0.0

Copyright © Parker PGI 2006 - 2013

Parker PGI

This software will allow you to communicate with the DB
system. Connect the DB controller SA-port to the PC serial
port to monitor, test, and configure the DB system. Also,

view and set the MODBUS Address. Refer to the DB
manual for details.

Figure 3-10. About DB Monitor screen
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3.4 Preparing for Start-Up

Prior to starting up the DB1 system, follow the procedure below to set up the DB Monitor software.

1. From the menu bar, click Setup > Tag Name (or press the F9 key). See Figure 3-11 below.

< DB Monitor Version 2.0.0.0

Reset Avg Cycle Timers..

File View @ Calbrate  Test Help
A Charger... FS

Alarms... Fé

Event Clock.., F7

Controller

Service Reminder... F8
Tag Mame,.. F9
Serial Ports... Alt+P

MODBUS Address 1

Generator

Hardware Revision: 1
Firmware Revision: 10

Model: DB 50 Watt Generator

COM10 | Online - Retrieving Status

Figure 3-11. Select Tag Name from DB Monitor Setup menu

2. Inthe text box type in a unique description of the DB unit (i.e. location, number, etc.). Click DB Save. See
Figure 3-12 below.

Edit DB Controller Tag Name

Tag Name:

\Parker PGI DB1-50

3 characters left

Figure 3-12. Edit DB Controller Tag Name text box
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3. Click Setup > Charger (or press F5). On the Setup Charger screen (Figure 3-13 below), set up the
following:

e Battery type: Select 12 Volt Lead Acid or 24 Volt Lead Acid.
e Temperature scale: Select Fahrenheit or Celsius.

¢ Remote shutdown: If a remote shutdown device will be used, click the Enable RSD Input checkbox.

Setup Charger

() 12Volt Lead Acid Low Battery <

O 24Volt Lead Acid % of Discharge Lz
Settings at 74°F

(3) Fahrenheit Full Charge: 15.06 %

O\ Casiss Low B attery: 1221V

Enable RSD Input

Figure 3-13. Setup Charger screen

4. Click DB Save to save the changes or Exit to discard them.

5. Click Setup > Alarms (or press F6). The Setup Alarms screen will be displayed. This screen displays the
list of alarms that notify the technician of undesirable conditions. The recommended settings are shown in
Figure 3-14 (page 29).

Note the following:
e A major alarm will disable the charger.

e The alarm LED will flash red to indicate a major alarm or yellow to indicate a minor alarm. For more on
the alarm LEDs, refer to “Alarm Contacts” (page 20).

e Latched alarms require the technician to make repairs and reset the charger to clear the alarm. Non-
latched alarms will be cleared automatically after the condition is removed.
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Setup Alarms -- Maps Alarms to Outputs

Major Alarms
Output
Num. 1 2

el = EE E E

Minor Alarms
Output
Num. 41 2

—_

| |
141 \A‘ w-\ -\ w- ‘~‘ w-w
(>)]

@

Major alarms will disable the generator when detected. [No charging).
The Alarm LED will flash red and the Alarm Output driven low on the selected outputs.

Lost Generator Communications Link [Non-Latched)
Control Yalve is Full Dpen but no RPM Detected [Latched)
Control Yalve Failed [Latched)

Generator RPM or Yoltage Output Too High [Latched)
Turbine RPM Sensor Failed [Latched)

Control Valve Position Sensor Failed (Latched)

Minor alarms are informative. Alarms 7, 9& 13 also disable the generator [no charging).

The &larm LED will flash yellow and the Alarm Output driven low on the selected outputs.

Controller Switch is in Disable Position ([Non-Latched)

Unable to Generate Marimum Power with Control Valve Full Open [Latched)
RSD (Remote Shut Down) Input Detected [Non-Latched)

Generator Run Time Service Due [Latched)

Temperature Sensor Failed (Non-Latched)

Unable to Reach Full Battery Charge [Non-Latched)

Modbus Shut Down (Latched)

- Latched alarms require the operator to make repairs and/or reset
the charger to clear the alarm.

Figure 3-14. Setup Alarms screen

will display the time and date on the PC. Click DB Save to set the event clock.

Set Event Clock

Click DB Save to set the event clock
to match the PC Time and Date

PC Time and Date

8:56:02 AM
3/4/2013

[] Use 24 Hour Format

Figure 3-15. Set Event Clock screen

From the menu bar, click Setup > Event Clock (or press F7). The Set Event Clock box (Figure 3-15 below)
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7. Click Setup > Service Reminder (or press F8). The Setup Service Reminder box will appear (Figure 3-16
below). It is recommended that the service reminder be set at 5000 hours. Click DB Save to save the
change.

Setup Service Reminder

Provide Service Due notice after 5000 hours of generatar run-time.

Figure 3-16. Setup Service Reminder screen

Reset total Run Time...

8. From the menu bar, click Calibrate > Battery Volts (Figure 3-17 below).

<) DB Monitor, Version 2.0.0.0

File  View 3Setup | Calibrate I Test  Help
S | Battery Yolts...
il Status | Conf Battery Temp...
Controller | Generator Volts. .,

Taq: Parker PGI DB1-50
Model: DB Battery Charger Controller

Hardware Revision: 7
Firmware Revision: 38
Calibration Date: Monday, March 04, 2013
MODBUS Address: 1

Generator

Model: DB 50 W att Generator

Hardware Revision: 1
Firmware Revision: 10

COM10 | Online - Retrieving MODBUS Address

Figure 3-17. Select Battery Volts from Calibrate menu
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9. Use a voltmeter to measure the actual battery voltage. Enter that value into the text box on the Calibrate
Battery Monitor screen (Figure 3-18 below). Click Update to save.

/I IMPORTANT! /I\

If the initial value in the text box matches the voltmeter reading, enter the value again and click
DB Save. This will capture and save all the data values. Otherwise, the default values will
reappear if the controller is disabled.

Note: When the Battery Volts value is changed, the calibration date will also change.

Calibrate Battery Monitor

1: Measure the actual battery voltage at the battery
terminals and enter the value below

2. Click [DB Save] to save to the DB Controller

Battery measures \ 12.03 | volts

Figure 3-18. Calibrate Battery Monitor screen

10. From the menu bar, click Calibrate > Battery Temp (Figure 3-19 below). Measure the temperature near
the battery, and enter the value in the text box provided. Click DB Save to save the value.

Calibrate Battery Temperature Monitor

1: Measure the actual battery temperature near the battery
and enter the value below

2: Click [DB Save] to save to the DB Controller

Actual Battery Temp. | 8] | °F

Figure 3-19. Calibrate Battery Temperature screen
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11. Click Calibrate > Generator Volts (Figure 3-20 below). With the generator in standby (controller switch set
to DISABLE), measure the battery voltage and enter the value in the text box provided. Click DB Save to
save the value.

Calibrate Generator Yoltage Monitor

1: Measure the generator voltage and enter the value below
2: Click [DB Save] to save to the Generator Controller

Generator measures | [HBEl | volts

Figure 3-20. Calibrate Generator Voltage Monitor screen

12. Click the Status tab to view the present state of the generator and battery. An example of the information
displayed is shown in Figure 3-21 (page 33).

In the Battery block of the Status screen, the present state of the battery (12.55 volts) and the battery
temperature (73°F) are displayed.

To view a chronological list of events, click # New Events (125 new events in the example shown).

If an alarm condition exists, it will be indicated in the Alarm 1 or Alarm 2 block. To display the alarm
descriptions, click the Configuration tab (Figure 3-22, page 33).

The Charger block contains two sections: Setpoints and Generator. Under Setpoints, the Full Charge,
Low Battery, and Charge Current values are displayed. When the DB1 controller switch is toggled to
the ON position and the battery voltage (displayed in the Battery block) drops below the low battery
value, the controller will determine the charge current necessary to reach the full charge value. The
generator will attempt to match the calculated charge current. The control valve will open until the
turbine reaches the speed at which the milliamps produced by the generator equals the required charge
current. The control valve will remain open until the full charge value is achieved.

Note: (1) The amount of charge delivered to the battery is calculated with consideration to the battery
temperature. (2) Conditions may exist that can cause inconsequential fluctuations in the current
produced.

Under the Generator section of the Charger block, the Charging, Avg Charge Time, Avg Discharge Time,
Avg Total Cycle Time, and Total Run Time values are displayed. The charging values show the status of
the generator as it attempts to match the calculated charge current. The average charge, average
discharge, and average total cycle times are used to calculate the total run time since the last
configuration update.

Note: Data must be compiled over a period of time before calculations can be made.
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B DB Monitor Version 2.0.0.0
File  View  Setup  Calibrate  Test Help

===

|1D. [ Status | Configuration | MODBUS |

....................

Baltey

Setpoints
13.29 volts Ff2°F Full Charge: 1510V
Low Battery: 1220V
Charge Current: 4000 maA
Generator
02:02:55 PM Charging 50.7 watts
04/08/13 38 New Events 13.63 vols
3721 mémps
Alarm Output] Alarm Output2 2354 RPM
o o Avg Charge Time: 0:00:28
Avg Discharge Time:  0:00:37
s Awvg Total Cycle Time:  0:01:05
Total Run Time: 0:15:02
Run Enabled Service Due In: 5,000 hours

COMZl‘ Online - Retrieving ID

Figure 3-21. Status tab

B DB Monitor Version 2.0.0.0

Eile  Miew  Setup  Calibrate Test He
ion | MODBUS

Ip

1.D. | Status |} |
Outpu

Edit Configuration... 12

o Enabled Edit alaims...

Battery Type: 12 Volt Lead Acid

Lost generator com link

Low Battery:  20% of Discharge

Yalve full open but no RPM detected

RSD Input: Enabled

Control valve failed

(op RS BB S (RN 0 AN S
LEE RE BN BN

A Generator over-rev shutdown
| Turbine RPM Sensor failed
5 Control Y alve Position Sensor Failed
r
m |7 = | Controller switch in disable position
s | 8 = | Unable to generate max power
] = | RSD Input detected
10 = | Service due
11 = | Temperature Sensor Failed
12 = | Unable to reach full charge
13 = | Modbus Shut Down
COM21 | Online - Retrieving Retry Count
Figure 3-22. Configuration tab
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3.5 System Start-Up

/I\ WARNING! /I\

Check field wiring and all connections before starting up the system.

/I\ WARNING! /I\

Test all connections for gas leaks.
Follow the steps below to start the DB1 system.
1. Connect the diagnostics cable (SK-DB1-003) from the PC to the controller.
2. Open the main shutoff valve.
3. Toggle the DB1 ON/ DISABLE switch to the ON position (Figure 3-23 below).

ON / DISABLE toggle switch

Figure 3-23. DB1 ON / DISABLE switch

When the ON / DISABLE switch is toggled ON, the controller will determine if the battery needs to be charged.
If a charge is needed, the controller will then determine the charge level required and open the control valve
accordingly. The control valve will be held open by the controller until one of the following conditions occurs:

e The ON/ DISABLE switch is toggled to the DISABLE position,
e The battery is fully charged, or
¢ The internal diagnostics detects a problem with the system.

When gas flow is introduced to the DB1, the turbine will begin to spin, generating power. Once the battery has
been fully charged, the controller will close the control valve and enter a standby mode.

3.6 System Shutdown

To shut down the DB1 system, toggle the ON / DISABLE switch to the DISABLE position. The controller will
close the control valve.
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3.7 System Tests

The DB Monitor software provides test functions for alarm outputs, the generator, and the control valve.

3.7.1 Alarm Outputs

To test the alarm outputs and alarm LEDs, select Test > Alarm Outputs. Follow the instructions provided on
the screen that appears (Figure 3-24 below).

To Test Alarm Outputs and LEDs

Use the Setup Alarms dialog to link an alarm
output to the Alarm7? - "Controller Switch is in
Disable Position". Functionality of the alarm
output can then be tested by physically togaling
the Controller Switch and verifying output
changes.

Figure 3-24. Test Alarms screen

3.7.2 The Generator

To test the generator when in Standby mode, select Test > Charger. In the screen that appears, click START
and the generator will start and continue to run until stopped manually by clicking STOP or the battery voltage
reaches the full charge setpoint. See Figure 3-25 below.

Test Charger - Generator Manual Controls

START... STOP

Exit

Figure 3-25. Test Charger - Generator Manual Controls screen
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3.7.3 Control Valve

To view the operation (CLOSING / STOPPED / OPENING) of the control valve while it adjust for maximum power
output, select Test > Control Valve. The screen that appears will display, in real time, the movement of the
internal control valve as it adjusts the flow of gas through the turbine in order to produce the maximum power
output. MAX CLOSED means the valve is completely closed and there should be no gas flowing through the
turbine. MAX OPEN means the valve is completely open and the generator is producing the maximum amount
of power it can produce with the provided differential pressure.

Control Yalve Test

O CLOSING B STOPPED O OPENING

Max CLOSED

Position Sensor: BLOCKED

Figure 3-26. Control Valve Test screen
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4 Maintenance & Troubleshooting

The DB1’s sturdy construction and limited number of moving parts equate to high reliability and low maintenance.
However, there are variables that occur during normal operation that may affect the life and operation of the DB1
system.

What follows are potential issues, causes, and possible remedies for various system components.

/I\ WARNING! /I\

Do not perform any service on the DB1 system unless the area is known to be non-hazardous!

/I\ WARNING! /I\

Prior to performing any service to the DB1 system, review Figure 4-1 below.

Prior to performing any service to the DB1 system:
e Togglethe ON / DISABLE switch to DISABLE.

e Completely disconnect system from battery.
e Close the supply gas main shutoff valve. @
e Close the downstream outlet valve. @

e Purge the DB1 by loosening one of the fitting nuts on the transition tube. @

[

—HHEHFF—

Figure 4-1. Steps required prior to performing service
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4.1 DB1 Valve
Problem
There is a leak around the valve stem area.

Possible Cause

o Aleak from the stem area indicates the valve stem packing has been depleted or has failed. This type

of leak would create a hazardous condition.

e A leak through the valve when fully closed indicates damage to the valve seat. In this case, the

generator turbine may continue to run when the valve is fully closed, although not fast enough to

produce current.
Solution
Replace the valve: Service kit number SK-DP1-C60-002.

4.2 Valve Motor
Problem

The valve will not open (or close).
Possible Cause

e The gears in the valve motor may become worn.

¢ The valve motor could be damaged by a lightning strike or other power surge.

Solution
Replace the valve motor: Service kit number SK-DP1-C60-009.

4.3 Bearing
Problem
The generator is noisy and / or vibrating.
Possible Cause
e The bearing may not have sufficient lubrication.
e The bearing may become damaged by dirty supply gas.
e A worn bearing can prevent the generator from turning properly.
Solution
Replace the bearing: Service kit number SK-DP1-C50-015.
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4.4 Electronics
Problem
The generator will not start up due to communication loss between the controller and generator.
Possible Cause
An electrical component could be damaged by a lightning strike or other power surge.
Solution
Replace the parts.
e Generator board: Service kit number SK-SS-C85-1522.
e Controller board: Service kit number SK-DP1-C60-005.
e Battery interface board: Service kit number SK-DP1-C60-010.

4.5 Support

Before contacting technical support, please have the following information available:
e Unit model number (DB1-10, DB1-20, or DB1-50)

e Pipeline pressure and flow rate

o Differential pressure

e Power requirements
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4.6 Warranty

OFFER OF SALE

The items described in this document and other documents and descriptions provided by Parker Hannifin Corporation, its subsidiaries and its authorized distributors (“Seller”)
are hereby offered for sale at prices to be established by Seller. This offer and its acceptance by any customer (“Buyer”) shall be governed by all of the following Terms and
Conditions. Buyer's order for any item described in its document, when communicated to Seller verbally, or in writing, shall constitute acceptance of this offer. All goods,

services or work described will be referred to as “Products”.

1. Terms and Conditions. Seller's willingness to offer Products, or accept an
order for Products, to or from Buyer is subject to these Terms and Conditions or
any newer version of the terms and conditions found on-line at

www .parker.com/saleterms/. Seller objects to any contrary or additional terms or
conditions of Buyer's order or any other document issued by Buyer.

2. Price Adjustments; Payments. Prices stated on Seller's quote or other
documentation offered by Seller are valid for 30 days, and do not include any
sales, use, or other taxes unless specifically stated. Unless otherwise specified by
Seller, all prices are F.C.A. Seller's facility INCOTERMS 2010). Paymentis
subject to credit approval and is due 30 days from the date of invoice or such
other term as required by Seller's Credit Department, after which Buyer shall pay
interest on any unpaid invoices at the rate of 1.5% per menth or the maximum
allowable rate under applicable law.

3. Delivery Dates; Title and Risk; Shipment. All delivery dates are approximate
and Seller shall not be respensible for any damages resulting from any delay.
Regardless of the manner of shipment, title to any preducts and risk of loss or
damage shall pass to Buyer upen placement of the products with the shipment
carrier at Seller's facility. Unless otherwise stated, Seller may exercise its
judgment in choosing the carrier and means of delivery. No deferment of shipment
at Buyers' request beyond the respective dates indicated will be made except on
terms that will indemnify, defend and hold Seller harmless against all loss and
additional expense. Buyer shall be responsible for any additional shipping
charges incurred by Seller due to Buyer's acts or omissions.

4. Warranty. Seller warrants that the Products sold hereunder shall be free from
defects in material or workmanship for a period of twelve months from the date of
delivery to Buyer or 2,000 hours of normal use, whichever occurs first. The prices
charged for Seller's products are based upon the exclusive limited warranty stated
above, and upon the following disclaimer: DISCLAIMER OF WARRANTY: THIS
WARRANTY COMPRISES THE SOLE AND ENTIRE WARRANTY PERTAINING
TO PRODUCTS PROVIDED HEREUNDER. SELLER DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS AND IMPLIED, INCLUDING DESIGN,
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

5. Claims: Commencement of Actions. Buyer shall promptly inspect all
Products upon delivery. No claims for shortages will be allowed unless reported to
the Seller within 10 days of delivery. No other claims against Seller will be allowed
unless asserted in writing within 30 days after delivery. Buyer shall notify Seller of
any alleged breach of warranty within 30 days after the date the defect is or
should have been discovered by Buyer. Any action based upon breach of this
agreement or upon any other claim arising out ofthis sale (other than an action by
Seller for an amount due on any invoice) must be commenced within 12 months
from the date of the breach without regard to the date breach is discovered.

6. LIMITATION OF LIABILITY. UPON NOTIFICATION, SELLER WILL, AT ITS
OPTION, REPAIR OR REPLACE A DEFECTIVE PRODUCT, OR REFUND THE
PURCHASE PRICE. IN NO EVENT SHALL SELLER BE LIABLE TO BUYER
FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF, OR AS THE RESULT OF, THE SALE,
DELIVERY, NON-DELIVERY, SERVICING, USE OR LOSS OF USE OF THE
PRODUCTS OR ANY PART THEREOF, OR FOR ANY CHARGES OR
EXPENSES OF ANY NATURE INCURRED WITHOUT SELLER'S WRITTEN
CONSENT, EVEN IF SELLER HAS BEEN NEGLIGENT, WHETHER IN
CONTRACT, TORT OR OTHER LEGAL THEORY. IN NO EVENT SHALL
SELLER'S LIABILITY UNDER ANY CLAIM MADE BY BUYER EXCEED THE
PURCHASE PRICE OF THE PRODUCTS.

7. User Responsibility. The user, through its own analysis and testing, is solely
responsible for making the final selection of the system and Product and assuring
that all performance, endurance, maintenance, safety and warning requirements
ofthe application are met. The user must analyze all aspects of the application
and follow applicable industry standards and Product information. If Seller
provides Product or system options, the user is responsible for determining that
such data and specifications are suitable and sufficient for all applications and
reasonably foreseeable uses ofthe Products or systems.

8. Loss to Buyer's Property. Any designs, tools, patterns, materials, drawings,
confidential information or equipment furnished by Buyer or any other items

which become Buyer's property, will be considered obsolete and may be
destroyed by Seller after two consecutive years have elapsed without Buyer
ordering the items manufactured using such property. Seller shall not be
responsible for any loss or damage to such property while itis in Seller's
possession or control.

9. Special Tooling. A tooling charge may be imposed for any special tocling,
including without limitation, dies, fixtures, molds and patterns, acquired to
manufacture Products. Such special tooling shall be and remain Seller's property
notwithstanding payment of any charges by Buyer. In no event will Buyer acquire
any interest in apparatus belonging to Seller which is utilized in the manufacture of
the Products, even if such apparatus has been specially converted or adapted for
such manufacture and notwithstanding any charges paid by Buyer. Unless
otherwise agreed, Seller shall have the right to alter, discard or otherwise dispose
of any special tocling or other property in its sole discretion at any time.

10. Buyer's Obligation; Rights of Seller. To secure payment of all sums due or
otherwise, Seller shall retain a security interest in the goods delivered and this
agreement shall be deemed a Security Agreement under the Uniform Commercial
Code. Buyer authorizes Seller as its attorney to execute and file on Buyer's behalf
all documents Seller deems necessary to perfect its security interest.

11. Improper use and Indemnity. Buyer shall indemnify, defend, and hold

Seller harmless from any claim, liability, damages, lawsuits, and costs (including

attorney fees), whether for personal injury, property damage, patent, trademark or
copyright infringement or any other claim, brought by or incurred by Buyer,
Buyer’s employees, or any other person, arising out of: (a) improper selection,
improper application or other misuse of Products purchased by Buyer from Seller;
(b) any act or omission, negligent or otherwise, of Buyer; (c) Seller's use of
patterns, plans, drawings, or specifications furnished by Buyer to manufacture
Product; or (d) Buyer's failure to comply with these terms and conditions. Seller
shall not indemnify Buyer under any circumstance except as otherwise provided.
12. Cancellations and Changes. Orders shall not be subject to cancellation or
change by Buyer for any reason, except with Seller's written consent and upon
terms that will indemnify, defend and hold Seller harmless against all direct,
incidental and consequential loss or damage. Seller may change product features,
specifications, designs and availability with notice to Buyer.

13. Limitation on Assignment. Buyer may not assign its rights or obligations
under this agreement without the prior written consent of Seller.

14. Force Majeure. Seller does not assume the risk and shall not be liable for
delay or failure to perform any of Seller’s obligaticns by reason of circumstances
beyond the reasonable control of Seller (hereinafter “Events of Force Majeure”).
Events of Force Majeure shall include without limitation: accidents, strikes or labor
disputes, acts of any government or government agency, acts of nature, delays or
failures in delivery from carriers or suppliers, shortages of materials, or any other
cause beyond Seller’s reasonable control.

15. Waiver and Severability. Failure to enforce any provision of this agreement
will not waive that provision nor will any such failure prejudice Seller’s right to
enforce that provision in the future. Invalidation of any provision of this agreement
by legislation or other rule of law shall not invalidate any other provision herein.
The remaining provisions of this agreement will remain in full force and effect.

16. Termmination. Seller may terminate this agreement for any reasen and at any
time by giving Buyer thirty (30) days written notice of termination. Seller may
immediately terminate this agreement, in writing, if Buyer: (a) commits a breach of
any provision of this agreement (b) appointments a trustee, receiver or custodian
for all or any part of Buyer’s property (c) files a petition for relief in bankruptcy on
its own behalf, or by a third party (d) makes an assignment for the benefit of
creditors, or (e) dissolves or liquidates all or a majority of its assets.

17. Governing Law. This agreement and the sale and delivery of all Products
hereunder shall be deemed te have taken place in and shall be governed and
construed in accordance with the laws ofthe State of Ohio, as applicable to
contracts executed and wholly performed therein and without regard to conflicts of
laws principles. Buyer irrevocably agrees and consents to the exclusive
jurisdiction and venue of the courts of Cuyahoga County, Ohio with respect to any
dispute, controversy or claim arising out of or relating to this agreement.

18. Indemnity for Infringement of Intellectual Property Rights. Seller shall
have no liability for infringement of any patents, trademarks, copyrights, trade
dress, trade secrets or similar rights except as provided in this Section. Seller will
defend and indemnify Buyer against allegations of infringement of U.S. patents,
U.S. trademarks, copyrights, trade dress and trade secrets (“Intellectual Property
Rights”). Seller will defend at its expense and will pay the cost of any settlement or
damages awarded in an action brought against Buyer based on an allegation that
a Product sold pursuant to this Agreement infringes the Intellectual Property
Rights of a third party. Seller's cbligation to defend and indemnify Buyer is
contingent on Buyer notifying Seller within ten (10) days after Buyer becomes
aware of such allegations of infringement, and Seller having sole control over the
defense of any allegations or actions including all negotiations for settlement or
compromise. If a Product is subject to a claim that it infringes the Intellectual
Property Rights of a third party, Seller may, at its sole expense and option,
procure for Buyer the right to continue using the Product, replace or modify the
Preduct so as to make it noninfringing, or offer to accept return of the Product and
return the purchase price less a reasonable allowance for depreciation.
Notwithstanding the foregoing, Seller shall have no liability for claims of
infringement based on information provided by Buyer, or directed to Products
delivered hereunder for which the designs are specified in whole or part by Buyer,
or infringements resulting from the modification, combination or use in a system of
any Product sold hereunder. The foregoing provisions of this Section shall
constitute Seller's sole and exclusive liability and Buyer's sole and exclusive
remedy for infringement of Intellectual Property Rights.

19. Entire Agreement. This agreement contains the entire agreement between
the Buyer and Seller and constitutes the final, complete and exclusive expression
of the terms of sale. All prior or contemporanecus written or oral agreements or
negotiations with respect to the subject matter are herein merged.

20. Compliance with Law, U. K. Bribery Act and U.S. Foreign Corrupt
Practices Act. Buyer agrees to comply with all applicable laws and regulations,
including both those of the United Kingdom and the United States of America, and
of the country or countries of the Territory in which Buyer may operate, including
without limitation the U. K. Bribery Act, the U.S. Foreign Corrupt Practices Act
(“FCPA”) and the U.S. Anti-Kickback Act (the “Anti-Kickback Act”), and agrees to
indemnify and hold harmless Seller from the consequences of any violation of
such provisions by Buyer, its employees or agents. Buyer acknowledges that they
are familiar with the provisions of the U. K. Bribery Act, the FCPA and the Anti-
Kickback Act, and certifies that Buyer will adhere to the requirements thereof. In
particular, Buyer represents and agrees that Buyer shall not make any payment or
give anything of value, directly or indirectly to any governmental official, any
foreign political party or official thereof, any candidate for foreign political office, or
any commercial entity or person, for the purpese of influencing such person to
purchase products or otherwise benefit the business of Seller.
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Appendix A The COM Communication Option

A.1 Introduction

Al1l Overview

An option for the DB1 battery charger is available that allows for MODBUS communication using RS485 or
Ethernet connection. This appendix provides information specific to this option. It is assumed that the user is
knowledgeable of MODBUS, and therefore, discussion on the MODBUS standard is not included. For information
on the standard, refer to wvw.MODBUS.org.

A.1l.2 Specifications

Specifications for the DB1 system with the COM communication option are provided in Table A-1 (page 42).

Rev 06 41 Parker PGI


file:///C:/Users/MV2AMM/Documents/Anns%20Work/PGI/DB1%20Comm%20project/www.MODBUS.org

Table A-1. DB1 battery charger with COM communication option specification

Input voltage

11 — 30 Vdc (supplied by controller)

Input current

80 mA at 12.4 V typical (280 mA maximum when
Ethernet active)

Operating temperature range

-40°F to 140°F (-40°C to 60°C)

Connections

RS485, Ethernet

Multi-drop

Up to 256 (depending on cabling)

User-selectable RS485 termination jumpers

Load termination
Reference to +V and GND
Add series resistance to GND signal

Electrical isolation

Certifications for individual components, not as an
assembly.

Isolated power supply:
Up to 3 kV for 1 second

CB Test Report: US/14402A/UL IEC 60950-1:2001
1st Ed.

UL General Safety Report: E3224736 UL 60950-1
1st Ed.

CUL General Safety C22.2 No. 60950-1-03
EN Medical Safety Report: SPC1005061 EN60601-1

EN General Safety Report: SPCLVD1005061
EN60950-1, 2nd Ed.

RS485 integrated circuit:
Galvanically isolated
UL 1577, IEC 60747-5-2 (VDE 0884, Rev 2)
IEC 61010-1, IEC 60950-1, and CSA Approved
Thermal shutdown protection
Low bus capacitance: 16 pF (typical)
Typical transient immunity: 50 kV/ms
Failsafe receiver for bus open, short, idle
Meets or exceeds TIA/EIA RS485
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A.13 DB1 Controller with Communication Module

With the COM communication option, a communication (COM) module is added to the standard DB1 controller.

This COM module adds LEDs for remote communication, RS485 and Ethernet ports, an 8-position connector,
and the COM wire harness. See Figure A-1 below.

s LEDs
8-position connector N
on other side of
module
Ethernet
port
Comm wire RS485 pOft
harness

Figure A-1. COM module for COM communication option

A.l4 LEDs for Remote Communication
Figure A-2 below shows the status LEDs for remote communication.
Receive (RX)

Transmit (TX)

Figure A-2. Status LEDs for remote communication
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Table A-2 below describes the status indicated by each LED.

Note: These LEDs have no relevance when the diagnostics cable (SK-DB1-003) is connected to the controller.

Table A-2. Status indicated by remote communication LEDs

LED Color Status
COMM good Green (solid) Communication has been received and is good.
Receive (RX) Red (flashing) |Communication on the network is present. Activity does not

necessarily mean the battery charger is addressed, but
indicates all activity if there are other devices on the same
network.

Transmit (TX) Amber (flashing) | The battery charger is transmitting.

A.15 RS485 & Ethernet Communication
The COM module provides one RS485 port and one Ethernet port (Figure A-3 below).

RS 485 Ethernet
GND D+ D-

Ethernet status LEDs

RS485 port Ethernet port

Figure A-3. RS485 and Ethernet ports

The two Ethernet status LEDs are shown above in Figure A-3. The left LED indicates the speed of the network,
and the right LED indicates data activity. Unlike the RS485 network, Ethernet can have activity to only this device
or it can show activity any time traffic is present on the network, depending on how the Ethernet network is
implemented. Therefore, rely on the three communication LEDs on the controller for status.

The COMM Good LED will show if the MODBUS commands are being responded to.

NOTE: If using Ethernet, remember to enable the port using jumper across pins 1 and 2 (see Figure A-16).
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A.2 Installation

/I IMPORTANT! /I\

This section pertains to installation and wiring specific to the COM communication option only.
Refer to Chapter 2 (page 14) in conjunction with this appendix. Heed all warnings and cautions
provided for the standard installation and wiring.

A.2.1 Mounting the Controller

The only difference in installation between the standard DB1 system and the DB1l system with COM
communication is how the controller is mounted. Mounting of the generator and battery interface module is the
same.

Figure A-4 below provides a template for the controller mounting holes. Alternatively, use the controller itself to
locate and mark holes in the enclosure.

@3/16"
311716
N\ w4 o 13 = TN
\J/ \}/
1 1
15/8"
1 I
) - - - - /\'_
kl/ \L/

Figure A-4. Drill template for mounting the controller

A.2.2 Field Wiring

In addition to the standard wiring described in Chapter 2, two wires from the COM wire harness need to be
connected in parallel with BV and GND on the right side connector of the controller assembly. See Figure A-5
below.

Black [GND)~
S \ o ~Red (BV)
f/ /l \ \». \\ /,,» ~
o[Hbbbdje| |©]HOHHEH]®
RS 485 Ethernet
ADD JUMPER FOR ETHERNET GND D+ D-

® i

N

@)

®)

=

{"‘ ‘\\ 4 \awe \ \Ethernet Port
| | “Orange LRS 485 Port

I} | “Creen

| | white

’, 'Black & Brown

‘Red

Ethernet Jumper/

Figure A-5. BV and GND connections (as supplied)
Rev 06

45

Parker PGI



A.3 Communication

A.3.1 COM Wire Harness

With the COM communication option, a COM wire harness provides the communication link between the COM
module and the DB1 controller. The COM wire harness should be connected to the communication port on the
controller. See Figure A-6 below.

Comm wire
harness

Figure A-6. COM wire harness connected to controller communication port (as supplied)

A.3.2 RS485 Connection

Either RS485 or an Ethernet connection may be used (not both) for MODBUS communication. You will need to
provide the wiring RS485 or Ethernet wiring and a sealed penetration in the enclosure.

If using RS485, there should be no connection to the Ethernet port. The RS485 connection is electrically isolated
from the DB1 controller electronics. For the RS485 network connection, match the signals from the master to

the slave (i.e. D(+) to D(+) and D(-) to D(-)). Additionally, a signal return ground (not Earth ground) is available if
needed. See Figure A-7 below.

Note: Supplying power to the Ethernet module does not disable the RS485 port, and the RS485 may still be
used if there is not an Ethernet link. However, if the Ethernet option will not be used, you will save power
by not adding the Ethernet power jumper (refer to Section A.3.5).

RS485 port
(GND, D+, D)

Figure A-7. Connections for RS485
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A.3.3 Termination Jumpers

There are four termination jumpers that should only be used if the DB1 controller is the farthest device from the
master on the RS485 network. All jumpers supplied by Parker PGI are in the un-jumpered position, except for
J5. Do not change these jumpers unless the following conditions are required:

e J2is the termination for the last (most distant) RS485 node on the network. If the DB1 system is the last
device, jumper J2. There must be only one termination in the network. Refer to the MODBUS specification
at www.MODBUS.org for explanation.

e J1 and J4 are for establishing a center balanced reference between the isolated + volts and ground.
Jumper these two only if necessary. Both are needed if either is used.

e J5 s for the ground resistor bypass. Only remove if the cable installation requires it.

If the DB1 controller is the last device on the RS485 bus, jumpers are required. Follow the procedure below to

install these jumpers.
/I\ WARNING! /I\

Do not perform any service on the DB1 system unless the area is known to be non-hazardous!

/I\ WARNING! /I\

Review Figure 4-1 (page 37) prior to performing any service on the DB1 system.
1. Unplug all connectors from the assembly.

2. Reference Figure A-8 below. Remove the two bottom screws on both ends of the assembly. Loosen (do
not remove) the two top screws on the end with the Ethernet port.

Loosen screws.
Do not remove.

Remove screws.

Remove screws.

Figure A-8. Assembly screws to remove or loosen
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3. Separate the two halves of the assembly as shown below in Figure A-9. Set aside the top portion
(controller) with the endplates.

Figure A-9. Separate the assembly

4. Reference Figure A-10 below. With the LEDs facing away from you, slide the aluminum plate off to the right
side of the assembly to expose the circuit board.

Note: Do not remove circuit board from aluminum chassis.

Note: Do not allow the circuit board to shift in the chassis while removing the plate.

Figure A-10. Remove the aluminum plate

5. Reference Figure A-11 below and Figure A-12 (page 49). Reposition the included jumpers across the
required jumper blocks. At a minimum, J2 must be jumpered. If required, the termination can be balanced
between +V and GND by installing jumpers at J1 and J4 as well.

00-03-40-¥v-02-00 S

AL ==
| = |

J2

J4 J5

Figure A-11. Locations of termination jumpers
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+3.3V_ISO

Ré |
1.20K
% SMAJ7.0CA
= D3

J1

22-28-4020
B o
J2 | S
= e 120 SMAJ7.0CA 2
P i
= 22-28-4020 D4 =
'I J3
M 1757255
= R10
> % SMAJ7.0CA R21
D5 100
3 1.20K AN
22-28-4020 |
: -l
J5
[ [] 22-28-4020

Figure A-12. Termination jumpers schematic
6. Once jumpers are installed, reassemble the unit in reverse order.

Note: Install the aluminum plate from right to left, as shown below in Figure 44.

Note: Do not allow the circuit board to shift in the chassis while installing the plate.

Figure A-13. Install the aluminum plate
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A.3.4 RS485 2-Wire System

The RS485 port uses a 2-wire half duplex system. Figure A-14 below illustrates a typical 2-wire topology. If you
are using a 4-wire full duplex system, refer to Figure A-15 below to connect a 4-wire system to a 2-wire system.

5V
Pull Up
D1
% - 2 4
LT Balanced Pair LT
2 2 : 4
DO
¥ 3 Pull Down
Common
i
I
I
I
I
I
I
|
Figure A-14. Typical 2-wire topology
1
1
1
: 5V
1
1
1
: Pull Up
D1 :
- ¢ it
LT Balanced Pair LT
s 4 \ 4 \ 4
DO
g Pull Down
Common
—
: i :
: : |
I 1 \R/L%
i ! 1
: : |
| _Slave 2 i _Slave3 !
Figure A-15. Connecting a 4-wire system to a 2-wire system
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A.35 Ethernet Connection

If using Ethernet, there should be no wiring to the RS485 connector. A wire jumper must be installed across pins

1 and 2 of the 8-position connector. This jumper will supply power to the Ethernet module. See Figure A-16
below.

Note: Supplying power to the Ethernet module does not disable the RS485 port, and the RS485 may still be
used if there is not an Ethernet link. Both ports may not be used simultaneously.

Ethernet port Install jumper across
pins 1 & 2 for Ethernet

Figure A-16. Ethernet port and pins 1 and 2 of 8-position connector

A.4 Retrofitting an Existing DB1 Controller

To retrofit an existing DB1 controller, remove all connections from the existing controller. Then remove the
controller itself, and replace it with the new controller. The replacement assembly is specifically designed to

occupy the same footprint on the back plate of the enclosure. The unit will be taller; however, this is usually not
a problem.

Reference the field wiring sections in Chapter 2 and in this appendix for wiring details.
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A.5 Communication Setup

AS5.1 MODBUS

Note: Ensure DB Monitor software version 2.0 or higher is installed on your PC before continuing. The software
is available from the Parker PGI website. Refer to “The DB Monitor Software” (page 22) for software
installation instructions.

Note: Disconnect the COM wire harness from the controller communication port and connect the diagnostics
cable to establish communication with the software.

The default configuration for the software is described below. When setup is complete, the DB1 controller will
reload the stored MODBUS settings each time the ON /DISABLE switch is moved to the ON position and the

diagnostics cable is connected.

MODBUS parameters are set using the DB Monitor software version 2.0 or higher. The settings are configured
under the MODBUS tab (Figure A-17 below).

< DB Monitor, Version 2.0.0.0

File  Wiew Setup Calibrate Test Help

1.D. Status | Configuration |

MODBUS unit address: ‘717 Protocol Mode: TCP

Connection Port
() RS 485 (®) Ethemet

Settings

This PC's IP Address:
192.168.11.41

DB Modbus IP Address:
click to view/set

View/Set [P

COM10 | Online - Retrieving Settings

Figure A-17. MODBUS tab
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To start the DB Monitor software, follow the procedure below.

1. After connecting the diagnostics cable to the controller communication port, toggle the ON / DISABLE
switch to the ON position.

2. Double-click the DB Monitor program icon. The software will attempt to connect to the DB1 controller via
the last serial port used. If it cannot find that serial port, the software will ask for a new serial port. When
prompted, select the appropriate communication port for your PC.

3. Data fields will begin to fill in. See Figure A-18 below.

< DB Monitor, Version 2.0.0.0

File  Wiew Setup Calibrate Test Help

/| Status | Configuiation | MODBUS |

Controller
Tag: Parker PGI DB1-50

Model: DB Battery Charger Controller

Hardware Revision: 7
Firmware Revision: 38
Calibration Date: Monday, March 04, 2013
MODBUS Address: 1

Generator

Model: DB 50 Watt Generator

Hardware Revision: 1
Firmware Revision: 10

COM10 | Online - Retrieving MODBUS Address

Figure A-18. Unit information

4. |n order to use MODBUS, an address must be saved in the DB1 controller. This address should be
supplied by whomever operates the MODBUS master or SCADA system. If necessary, change the address
by entering the correct address in the MODBUS unit address field on the MODBUS screen.

5. If using RS485, click the RS485 button and verify the communication settings. The RS485 serial port is
able to operate from 1,200 to 38,400 baud. Default serial port parameters are:

Baud: 9600
Bits: 8

Parity: None
Stop Bits: 1

Change any settings as required and then click the Save to DB button to save the new settings.

Note: If using an Ethernet connection, continue to the next section to set the IP address.
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A.5.2 IP Address Setup

If using an Ethernet connection, the IP address needs to match the device installer. To setup the IP address,
follow the procedure below.

1. Using an Ethernet cable, connect your computer to the Ethernet port on the COM module. Ensure that the

Ethernet jumper on the 8-position connector is installed across pins 1 and 2. Refer to Figure A-16 (page
51).

2. Launch the DB Monitor software and click the MODBUS tab and select the Ethernet radio button. See
Figure A-19 below.

< DB Monitor Version 2.0.0.0

File  ¥iew Setup Calibrate Test Help

1.D. i‘”Status | ﬁbﬁfiguraﬁori!

MODBUS unit address: ‘ 1 | ProtocolMode: TCP

Connection Port

() RS 485 (%) Ethemet

Settings

This PC's IP Address:
192.168.11.41

DB Modbus IP Address:
click to view/set

View/Set IP

COMI10 | Online - Retrieving Settings

Figure A-19. Select Ethernet connection on MODBUS screen
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3. Click the View/Set IP button to launch the Device Installer software, which is included in the install package
of the DB Monitor software.

4. Click the + sign next to the XPort folder on the left side pane to expand it. See Figure A-20 below.

"% Lantronix Devicelnstaller 4.3.0.7 T=lle =
File Edit View Device Tools Help
SO Search @) Exclude & AssignIP

[EB-Y Lantronix Devices - 1 device(s)
[ Local Area Connection (169.254.243.119

Type Name Group IP Address Hardware Address Status
S XPort-03/04 169.254.236.144  00-204A-E7CD-B1 Online

Figure A-20. Set up IP address — Expand the XPort folder

5. Click the + sign next to XPort-03/04-firmware to expand it.
6. Once the IP address of the module is visible, single-click it to select it. In the example below, the IP
address is 169.254.236.144. Then click Assign IP button in the menu. See Figure A-21 below.

7% Lantronix Devicelnstaller 43.0.7 )
File Edit View Device Tools Help

»- Search @ Exclude | & AssignIP Q Upgrade

=38 Lantronix Devices - 1 device(s) Device Details | Web Configuration | Telnet Configuration
=] g’i‘g Local Area Connection (169.254.243.119 3
-3 XPort w Reload Details
£ XPort-03/04 -fimware v6.5.22.11 Propety Value -
= 2 20V o | Name XPort-03/04
W/" DHCP Device Name
Group
Comments
Device Family XPort
Type XPort-03/04
D X5
Hardware Address 00-20-4A-E7CD-B1
Fimware Version 6.5 L
Extended Fimware Version 65.22.1MB r
Online Status Online
IP Address 169.254.236.144
IP Address was Obtained Statically
Subnet Mask 255.255.0.0
Gateway 255.255.255.0
Number of COB partitions suppo... 6
Number of Ports 1
TCP Keepalive 45
Telnet Supported True E_
Telnet Port 9999
Web Port 80
Maximum Baud Rate Supported 230400
Fimware Upgradable True
Supports Configurable Pins True
] = I b Supports Email Triggers True -
V] Ready

Figure A-21. Set up IP address — Select IP address

Rev 06 55 Parker PGI



7. Inthe screen that appears, select Assign a specific IP address and click Next. See Figure A-22 below.

Assignment Method

Would you like to specify the IP address or should the unit get its
settings from a server out on the network?

() Obtain an IP address automatically

© Assign a specific IP address

| TCPjIP Tutorial |

< Back [ Next > ][ Cancel ][ Help

]

Figure A-22. Set up IP address — Assign specific IP address

8. Inthe next screen, enter the IP address and gateway settings in the IP address and Default gateway

fields respectively. Click Next. See Figure A-23 below.

IP Settings

Please fill in the IP address, subnet, and gateway to assign the device.
The subnet will be filled in automatically as vou type, but please verify
it for accuracy. Incorrect values in any of the below fields can make it
impossible for your device to communicate, and can cause network
disruption.

IP address: 169.254.236.144
Subnet mask: 255.255.0.0

Default gateway 255 255,255.0

[ < Back ]L Next >J[ Cancel ][ Help

l

Figure A-23. Set up IP address — Enter IP address and gateway
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9. At the next screen, click Assign to assign the IP address. See Figure A-24 below.

Assignment

Click the Assign button to complete the IP address assignment.

[ Assign ]

[ < Back ]| Finish J[ Cancel ][ Help

Figure A-24. Set up IP address — Complete IP address assignment

10. Once the progress bar is full and “Completed successfully” appears, click Finish. See Figure A-25 below.

Assignment

Click the Assign button to complete the IP address assignment.

Progress of task:

Completed successfully,

Finish ] [ Cancel ] [ Help

Figure A-25. Set up IP address — IP address assignment complete

11. Close the Device Installer software to return to DB Monitor.
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A.6 Operating Instructions

General operating instructions for the DB1 controller and the DB Monitor software are provided in Chapter 3
(page 19). This section provides operating information specific to operating the DB1 battery charger with the

COM communication option.
/I\ WARNING! /I\

Check field wiring and all connections before starting up the system.

/I\ WARNING! /I\

Test all connections for gas leaks.
Follow the steps below to start the DB1 system.
1. Connect the diagnostics cable (SK-DB1-003) from the PC to the controller.
2. Open the main shutoff valve.
3. Toggle the DB1 ON/ DISABLE switch to the ON position.

When the ON / DISABLE switch is toggled to the ON position, the controller will determine if the MODBUS
interface is present and if the battery needs to be charged. At all times during this operation, the software will
communicate with the controller and return data from the generator.

In order to view MODBUS data via the RS485 or Ethernet port:

1. Disconnect the diagnostics cable.

2. Connect the COM wire harness to the controller communication port.
3. Toggle the ON / DISABLE switch.
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A.7

DB1 Register Map

Modbus -
category  |vame-  SYSTEM INFO Register | L6 | r/w
5-digit
20 byte ASCI| text string - TAG (same as in DB Monitor) 40 001 0
User can assign TAG to identify unit R/W
User Tag Default "PARKER DB1 + MODBUS!" 40 010 9
20 byte ASCII text string - additional user Tag 40011 10
User can assign additional 20 characters R/W
Default "LINE 2 NAME " 40 020 19
20 byte ASCI| text string - System Model 40021 20
"DB1-10W" or "DB1-20W" or "DB1-50W" R
40 030 29
Serial Number (16-bit integer) 40 031 30 R
System Generator Hardware Revision (16-bit integer) 40032 31 R
fisEis Generator Firmware Revision (16-bit integer) 40 033 32 R
Controller Hardware Revision (16-bit integer) 40 034 33 R
Controller Firmware Revision (16-bit integer) 40 035 34 R
Reserved for Future Expansion 40 036 35
and additional System Components R
(ie, stacked generator #2, etc) 40 250 249
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Modbus .
category  |Name - OPERATIONAL Register | 16" | R/w
5-digit
Year - 2000 to 2099 40251 250
Month - 1 to 12 40252 251
Day-1to31 40253 252 R/W
Hour (24Hr) - 0 to 23 40254 253
Time Minute - 0 to 59 40 255 254
Clock Second - 0 to 59 40256 255
and Clock is Good
Date 1 =Good, 40257 256 R
0 = Failed clock HW, date/time not valid
Reserved =0 40 258 257 R
Reserved = 0 40 259 258 R
Reserved = 0 40260 259 R
Generator Volts x100 (16-bit integer)
0 to 655.35 V (after divide by 100) 40261 260 R
Generator Amps x100 (16-bit integer)
0 to 655.35 A (after divide by 100) 40262 261 R
Generator RPM (16-bit integer) 40263 962 R
0 to 65,535
Reserved =0 40 264 263 R
Generator Auto-Restart Retry Attempts Allowed
{Requires system reset to take effect) 40 265 264 R/W
Oto 10 Default =3
Generator Time between Auto- Restart Attempts
Generator .
#1 {Requires system reset to take effect) 40 266 265 R/W
1to 24 Hrs Default = 24 Hrs
Generator is Good
4 = Good normal operation
3 = Warning, operational but service required
2 = Good but in Wait to Auto-Retry 40267 266 R
1 = Good, but in manual shut down due to
RSD, ON/Disable in Disable or Modbus Shut Down
0 = Failed HW and requires service
Generator Diagnostic Info 40 268 267 R
Reserved =0 40 269 268 R
Generator Maximum Watts 40270 269 R
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Modbus :
category  [vame- OPERATIONAL (cont.)  [resister [ioioe | wiw
5-digit
Battery Voltage x100 (16-bit integer) 40271 270 R
0 to 655.35Volts (after divide by 100)
Battery Reserved =0 40272 271 R
Battery Reserved =0 40273 272 R
Battery Temperature C x100 (signed 16-bit integer)
-327.68 to 327.67 (after divide by 100) 40274 273 R
-45.55C = not installed or non functional sensor
Battery Battery Temperature F x100 (signed 16-bit integer)
-327.68 to 327.67 (after divide by 100) 40275 274 R
-50F = not installed or non functional sensor
Installed Battery Voltage (16-bit integer) 40276 575 R
12=12V, 24= 24V Default = 12
Battery Reserved =0 40277 276 R
Battery Reserved =0 40278 277 R
Battery Reserved =0 40279 278 R
Battery Reserved =0 40280 279 R
Charger Stage
2 - 2nd stage of charge cycle, 40 281 280 R
1 - 1st stage of charge cycle,
0 - not charging
Clfarger Typa 40282 | 281 R
O=cyclic
Maximum Cyclic Charge Timeout (16-bit integer)
Alarm12 parameter - this is the time allowed
before Alarm12 will be actived. Since this is a minor
. . 40 283 282 R/W
alarm the battery will continue to be charged as
Battery needed. Expressed in Hours.
Charger 1 to 1000 Default 120 Hrs
Charger Reserved =0 40 284 283 R
Charger Reserved =0 40 285 284 R
Average Cyclic Charge Time (16-bit interger)
in Hours X 100 40 286 285 R
i.e 5.5Hrs =550
Av‘erage Cyclic Discharge Time (16-bit interger) 40 987 286 R
in Hours X 100
Charger Reserved =0 40 288 287 R
Charger Reserved =0 40 289 288 R
Charger Reserved =0 40 290 289 R
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Modbus

Cotegoy  [name-  SERVICE & ALARMS Register [~ | r/w
5-digit
On Time Hours (16-bit integer)
Default 0 40291 290 R
Total accumulated on time of the controller
Generator Run Time Hours {(16-bit integer)
. Default 0 40292 291 R
Service )
Total accumulated run time of the generator.
Service Due in Hours {16-bit integer)
Default 5000 hours 40293 292 R
Generator suggested service interval.
Reserved =0 40 294 293 R
Alarm Outputl
1 - output being driven due to mapped alarm 40 295 294 R
0 - no alarm
Alarm Output2
1 - output being driven due to mapped alarm 40 296 295 R
Alarms 0 - no alarm
Alarm1 - Lost Generator Communications
(if does not clear by itself requies system reset to
clear. Possible service issue. Alarm1 is not latched.) 40 297 296 R

2 -in alarm, major -- diagnostic shutdown
0 -no alarm
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Category

SERVICE & ALARMS(cont.)

Modbus
Register
5-digit

Register
Address

R/W

ALARMS
(Cont.)

Alarm?2 - Generator Valve full open but no RPM
(Requires system reset to clear. May be due to lost
of differential pressure. Prior to the Alarm
the system will attempt auto-restart(s). Upon
failure to auto- restart(s) the Alarm is set and the
system is in diagnostic shutdown until service .
Alarm?2 is latched.)

3 - in alarm, major --diagnostic shutdown

0 - noalarm

40 298

297

Alarm3 - Generator Valve Fail
RPMs when full closed or
timeout when driving open/close
{Requires system reset to clear. Possible service issue
due to leaky valve, or position sensor. System is in
diagnostic shutdown until service. Alarm3 is latched.)
3 - in alarm, major -- diagnostic shutdown
0 - noalarm

40299

298

Alarm4 - Generator Over Rev/Voltage
(Requires system reset to clear. Possible Service issue.
System is in diagnostic shutdown until service. Alarm4
is latched.)

3 - in alarm, major -- diagnostic shutdown

0 - no alarm

40 300

299

Alarm5 - Generator RPM Sensor Failure
{Requires system reset to clear. Possible service issue.
System is in diagnostic shutdown until service.)

3 - in alarm, major -- diagnostic shutdown

0- no alarm

40301

300

Alarmé6 - Generator Valve Position Sensor Failure
(Requires system reset to clear. Possible service issue.
Alarmé6 is latched.)

3 - in alarm, major -- diagnostic shutdown

0 - no alarm

40 302

301

Alarm?7 - Controller Switch is in Disable Position
{Regires switch to be moved to ON to clear.)

1 - in alarm -- diagnostic shutdown

0 - no alarm

40 303

302
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Modbus .
categoy | SERVICE & ALARMS(cont.)  [register |5 | r/w
5-digit
Alarm8 - Unable to generate Max Power
{Requires system reset to clear. Possible low
differential Pressu.re. Wwill cc_)ntnue tf) ru.n the generator 40 304 303 R
and charge if possible. Possible service issue.)
1-inalarm
0 - no alarm
Alarm9 - RSD (Remote Shut Down)
(Requilres active F{_SD |npt.1t to be negated to clear) 40 305 304 R
1 - in alarm -- diagnostic shutdown
0 - no alarm
Alarm10 - Generator Run Time Service Due
{Requires service. Will continue to run generator
and charge if possible. ) 40 306 305 R
1-inalarm
0 - no alarm
Alarm11 - Battery Temperature Sensor Failure
(If does not clear by itself requires system reset
to clear. Will contnue to run the generato.r bl:lt use 68F 40 307 306 R
as the battery temperature. Possible service issue)
1-inalarm
0 - no alarm
Alarm12 - Battery unable to reach full charge
(If does not clear by itself requires system reset to
clear.. will rur.w ge_nerator in Stagel full charge. 40 308 307 R
Possible service issue)
1-inalarm
0 - no alarm
Alarm13 - Modbus Shut Down
(Requires Modbus device to negate to clear.)
. : g 40 309 308 R
1 - in alarm -- diagnostic shutdown
0 - no alarm
Reserved =0 40310 309
FUTURE R
40 350 349
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Modbus

i Register
category |name-  COMMUNICATIONS Register | | R/W
5-digit
Modbus ID (16-bit integer)
1to 247 Default=1 AR 250 Rpw
Modbus Reserved =0 40352 351 R
ModbusSerial Protocol Mode (16-bit integer)
2=TCP/IP,1=RTU, 0=ASClI Default=1 40 353 352 R/W
(Requires reset to take effect)
Modbus Serial RS-485 Baud (16-bit integer)
1200,2400,4800,9600,14400,19200,38400 Default = 9600 40 354 353 R/W
{Requires reset to take effect)
Modbus Parity (16-bit integer)
2=EVEN,
1=0DD, 40 355 354 R/W
0=NONE Default =0
{Requires reset to take effect)
Modbus Reserved 40 356 355 R
Modbus ASCII Protocol Timeout (16-bit integer) 40 357 356 R/W
1to 65,535 seconds Default=1
COMM Modbus Error Count (16-bt Integer) 40 358 357 R/W
Reboot Info (16-bit integer)
15=from disable SW.ItCh, 40 359 358 R
12=From power being off,
O=forced reset from Modbus coil command
Modbus Reserved =0 40 360 359 R
Modbus Reserved =0 40 361 360 R
b =
Modbus Reserved =0 40 362 361 R
Modbus Reserved =0 40 363 362 R
Modbus Reserved =0 40 364 363 R
Modbus Reserved = 0 40 365 364 R
Reserved =0 40 366 365
R
40 375 374
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Modbus

1 to 1000

Category Naine - EVENT LOG Register 2:3'::: R/W
5-digit
Reserved = 0 40 376 375
R
40 398 397
New Events in Event Log (16 bit integer) 40 399 398 R/W
Total Events in Event Log (16 bit integer) 40 400 399 R
Event Record #1 - 10 Registers 40 401 400
most current entry R
40 410 409
Logger Event Record #2 - 10 Registers 40411 410
next entry R
only valid if <= Total number of Events 40 420 419
Event Record #3 to #999 - 10 Registers each 40421 420
next entries R
only valid if <= Total number of Events 50390 | 10389
Event Record #1000 - 10 Registers 50391 | 10390
last entry R
only valid if <= Total number of Events 50400 | 10399
Modbus
Event Record - Structure Register
Offset
Year - 2000 to 2099 xx xx1
Month - 1 to 12 XX XX2
Day-1to31 xx xx3
Hour (24Hr) - 0 to 23 XX xx4
Minute - 0 to 59 XX Xx5
Second - 0 to 59 XX Xx6
Event Code
(see list for details) 07
Reserved = 0 XX Xx8
Battery Volts x100 {16-bit integer)
0 to 655.35 V (after divide by 100) R
Record Number
xx x10
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I-Event

Cora Description
0 * reserved event code (0)
1 Power ON
2 ON/Disable switch in DISABLE position
3 Event Table Cleared
4 New Events Tagged as Read
5 Generator Started
6 Generator Stopped
7 Temperature sensor failed, compensation disabled
8 Temperature sensor in range, compensation restored
9 code 9
10 RSD detected
11 RSD cleared
12 Lost communications link to Generator
13 Valve is full open but no RPM detected
14 Unable to generate max power with control valve full open
15 Unable to maintain full charge with max charging power
16 Unstable RPM detected
17 RPM detected with control valve full closed
18 Generator over-rev shutdown
19 Generator efficiency loss detected
20 Generator Disable - Diagnostics Shutdown
21 Service Due Timer Updated by Operator
22 Total Run-Time Updated by Operator
23 Generator Service Due
24 code 24
25 Control Valve Failed to Initialize
26 code 26
27 code 27
28 Unknown Generator Size or Type
29 Using Test Power Value
30 ALARM on Outl Active
31 ALARM on Out2 Active
32 ALARM on Outl Cleared
33 ALARM on Out2 Cleared
34 code 34
35 code 35
36 Battery voltage monitor calibrated
37 Battery temperature monitor calibrated
38 Charge current zero calibrated
39 Charge current gain calibrated
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Event

Description (Cont.)

Code
40 Generator voltage monitor calibrated
41 Event clock time and date set
42 Charger mode set to 12 volt battery
43 Charger mode set to 24 volt battery
44 Alarms 1 & 2 - Settings Updated
45 code 45
46 Calibration Date Updated
47 Tag Name Updated
48 Test charge current set
49 Configuration Updated
50 Generator Packet Timeout
51 Generator received packet checksum error
52 Generator received packet size error
53 MODBUS commanded 'Disable’
54 MODBUS commanded 'ON'
55 code 55
56 code 56
57 code 57
58 code 58
59 Generator received invalid command
60 Gen control - Max RPM delta adjusted
61 Gen control - Minimum motor PWM adjusted
62 Gen control - Valve open StopPoint adjusted
63 Gen control - Valve close DropPoint adjusted
64 Gen control - Setpoint deadband upper adjusted
65 Gen control - Setpoint deadband lower adjusted
66 Gen control - Defaults Restored
67 Turbine RPM sensor failed
68 Control valve position sensor failed
69 Unable to Reach Full Charge
70 Adjusted Timeout - for Unable to reach Full Charge
71 Full Open, No RPM Detected - Waiting to Retry
72 Full Open, No RPM Detected - Retrying Now
73 Full Open, No RPM Detected - Auto Count Reset
74 Adjusted Retry Delay - for Full Open, No RPM Alarm
75 Adjusted # Retry Limit - for Full Open, No RPM Alarm
76 Wait To Retry Overridden by Manual Charge Control
77 Wait To Retry Overridden by Diagnostic Shutdown
78 Wait To Retry Overridden by ON/Disable Switch
79 Control valve driving open timeout
80 Control valve driving close timeout
all others Unknown Event
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Event

Description (Cont.)

Code
40 Generator voltage monitor calibrated
41 Event clock time and date set
42 Charger mode set to 12 volt battery
43 Charger mode set to 24 volt battery
44 Alarms 1 & 2 - Settings Updated
45 code 45
46 Calibration Date Updated
47 Tag Name Updated
48 Test charge current set
49 Configuration Updated
50 Generator Packet Timeout
51 Generator received packet checksum error
52 Generator received packet size error
53 MODBUS commanded 'Disable’
54 MODBUS commanded 'ON'
55 code 55
56 code 56
57 code 57
58 code 58
59 Generator received invalid command
60 Gen control - Max RPM delta adjusted
61 Gen control - Minimum motor PWM adjusted
62 Gen control - Valve open StopPoint adjusted
63 Gen control - Valve close DropPoint adjusted
64 Gen control - Setpoint deadband upper adjusted
65 Gen control - Setpoint deadband lower adjusted
66 Gen control - Defaults Restored
67 Turbine RPM sensor failed
68 Control valve position sensor failed
69 Unable to Reach Full Charge
70 Adjusted Timeout - for Unable to reach Full Charge
71 Full Open, No RPM Detected - Waiting to Retry
72 Full Open, No RPM Detected - Retrying Now
73 Full Open, No RPM Detected - Auto Count Reset
74 Adjusted Retry Delay - for Full Open, No RPM Alarm
75 Adjusted # Retry Limit - for Full Open, No RPM Alarm
76 Wait To Retry Overridden by Manual Charge Control
77 Wait To Retry Overridden by Diagnostic Shutdown
78 Wait To Retry Overridden by ON/Disable Switch
79 Control valve driving open timeout
80 Control valve driving close timeout
all others Unknown Event
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Category

Name - RESETS

Modbus
Coil
5-digit

Data
Address

R/W

ON/Disable

Remote ON/Disable

Disable value = 0x0000 - force shut down (simulate
ON/Disable switch in DISABLE position)

ON value=0xFF0O - turn ON and force a reset
(simulate ON/Disable switch in the ON position)

00001

EVENT
LOG
clear

Event Log Clear

OFF value = 0x0000 - no change

ON value=0xFF0O0 force clear Event log
40 399 - New Events =0
40 400 - Total Events =0

one shot, after clearing will operate and start logging
including log of this clearing command

{Logs Event 3)

00002

Counter
reset

Counters Reset to zero
OFF value = 0x0000 - no change
ON value=0xFFOO - reset to zero the following:
40 286 - Average Cyclic Charge Time
40 287 - Average Cyclic Discharge Time
40 291 - Total Controller On Time
40 292 - Total Generator Run Time
And Reloads Default :
40 293 - Service Due Hours, Default 5000 Hours

one shot, after clearing will operate normal.
{Logs Event 22, Event 21)

00003

Generator
Start/Stop

Remote Generator Start/Stop

Stopvalue = 0x0000 - force genertor into
stop state. Note: When battery requires charging
the generator will restart normally.

Start value=0xFFQO - turn on the generator
Note: When battery is fully charged the generator
will stop normally.

00004
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A.8 Troubleshooting

Problem

RS485 - Failure to communicate

Possible Solutions

Ensure that the connecting cable is properly installed and that, if applicable, the 2-wire to 4-wire
connection is correct. (See Section A.3.4.)

Ensure that no Ethernet connection attempt is being made and that the jumper is removed from pins 1
and 2 of the 8-position connector. (See Section A.3.5.)

Using the DB Monitor software, verify that the RS485 port settings saved to the controller match those
at the remote connection.

If there are multiple devices in the network, verify the termination jumpers in the communication module
have been properly set and adjust if necessary. (See Section A.3.3.)

Problem

Ethernet - Failure to communicate

Possible Solutions

Ensure a standard Ethernet cable is being used. A cross-over cable is not required.

Verify that no RS485 connection attempt is being made and that a jumper is installed between pins 1 and
2 of the 8-position connector. (See Section A.3.5.)

Using the instructions provided, verify that the IP address saved to the communication module has been
properly set to work with the remote device network. (See Section A.5.2.)
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